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Board of Directors 
2000-2001 

 
LINDA BUSCH - President 
  lindashrub@juno.com 
  847.546.6728 
 
MIKE McENERY - Vice President—News Journal Editor    
mmcenery@core.com 
 847.872.1314 
 
TERRI HANLON - Secretary  
  TerHanlon@aol.com 
 
DWIGHT J.J. JOHNSON - Treasurer    
  jj1450xl@ix.netcom.com  
               847.623.3815 
 
CORKY BELL - Webmaster 
  corky@foxvalley.net 
 815.344.1271 
 
DONNA BELL - Membership Chairperson  
  donnabell1@juno.com  
  815.344.1271 

 
LESTER LARKIN -  Public Relations Chairperson 
  LesLarkin@NetZero.net 
 
 

The L.C.A.C.E. News Journal is published eleven times 
annually. Members are encouraged to submit contributions 
and will be acknowledged in this newsletter. 
 
Permission is granted to reproduce any or all parts of this 
newsletter in other User Group publications, provided that 
credit is given to L.C.A.C.E. and the individual author(s).  
 
The News Journal is produced using a Dell Dimension 4100 
Computer, Lexmark X83 scanner using  MS Publisher 2002 
software. Graphics editing and artwork provided by Pegasus 
Enterprises. Photos taken w/Olympus D-400 Zoom Photo 
PC digital camera. Printing is done on an Epson Stylus 
Color 880 Printer, and Adobe Acrobat for PDF conversion. 

Lake County Area Computer Enthusiasts 
L.C.A.C.E. 

c/o Group Ambassador 
409 S. Elmwood Ave. 

Waukegan, Illinois 60085-5219 
 

Membership 
Membership for L.C.A.C.E is open to all individuals and families 
interested in personal computing. Annual dues are $20.00 per 
individual/family. Associate membership is only $10.00 (out of 
state, unable to attend meetings). Membership includes a one 
year subscription to the L.C.A.C.E. News Journal and access to 
all club libraries and functions. Applications for membership 
may be obtained at the monthly meeting, by request on the club 
Hotline and are now available on our WEB site at http://inf-
net.com/lcace. 
 

Meetings 
L.C.A.C.E. meetings are held on the second Saturday of each 
month at the Grant Township Meeting Hall, 411 S. Washington 
Ave., Ingleside, (Fox Lake) Illinois. The meeting location opens 
at 11:30 a.m., and the formal meeting begins at noon. All 
meetings are open to the public.  Bring a friend! 
 

Advertising 
Ad rates per issue: Full page - $25, Half page - $15, Quarter page 
- $10, Business Card - $5. Discounts are available on advance 
purchase of multiple issues. Please send camera-ready copy and 
payment to the club address by the 21st of the month preceding 
publication. For more information on ad pricing, please call our 
Hotline. Ads are FREE to all paid members.  
 

Notice 
L.C.A.C.E  WILL NOT CONDONE  or knowingly participate 
in copyright infringement of  any kind. The L.C.A.C.E. News 
Journal is published by and for L.C.A.C.E. members. Opinions 
expressed herein are those of the individual authors and do not 
necessarily reflect the opinion of L.C.A.C.E., the membership, 
the Board of Directors, and/or our advertisers. 

ARTICLE DEADLINEARTICLE DEADLINEARTICLE DEADLINEARTICLE DEADLINE    
The deadline for all articles being submitted for the 
News Journal is the 20th of each month. Send your 
a rticles via e-mail to  Mike McEnery 
(mmcenery@core.com), or the Club’s e-mail at 
(lcace@inf-net.com). 

L.C.A.C.E. HOTLINEL.C.A.C.E. HOTLINEL.C.A.C.E. HOTLINEL.C.A.C.E. HOTLINE    
Call: 847.623.3815 or  fax: 413.521.7052 

  
e-mail: lcace@inf-net.com 

Web Site:  www.inf-net.com/lcace and http://lcace.tripod.com 

Lake County Area Computer Enthusiasts 
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On behalf of the Board and the 
Members of the Lake County 
Area Computer Enthusiasts, I 
want to give an especially big 
THANK YO U to Robin Seiden-
berg  for her fine job of getting 
our club some much needed PR 
and an even bigger THANK You 
for securing our new meeting site.  
She has gotten our new meeting 

place written up in the Waukegan News Sun (did you 
see it?) and the Lakeland Press Newspapers.  The 
Grayslake Library, I think, will help us bring in some 
new members and bring back some of our old members. 
      Linda 

Backup Plus  v6.0.6   
By Dwight (J.J.) Johnson 
 
I’m primarily a laptop user; therefore, all my important 
data could easily be lost while transporting my laptop 
from one location to another. I’ve found Backup Plus 
provides an easy way to backup my most important data 
to my external hard driver or to just about any remov-
able device including ZIP, JAZ, floppy disk, and CDR/
CDRW media disks. There is no mention of being able 
to back up to a DVD, but Backup Plus has the ability to 
write to just about any device in a single backup archive 
format and will span multiple disks on removable drives 
when more than one disk is required.  I haven’t tried to 
back up to a hard drive on my network, but I don’t see 
any reason it  shouldn’t work. 
 
The largest amount of data that can be backed up at any 
one time in one backup set is 4.0 GB. Therefore, it  is 
important to note that backups should only contain im-
portant files and data, such as E-Mail data, important 
document files, etc. 
 
The backup registry option allows you to quickly and 
easily backup your important system files.  Existing sys-
tem files will be searched for before this menu loads and 
will be listed for you. The Registry Backup is designed 
specifically for Windows 95/98/ME and XP systems 
only.  If you are using Windows NT or Windows 2000, 

the Registry Backup will not include all needed files. 
  
I created backup sets of all my important data (Quicken, 
Family Tree Maker and Outlook .PST files) Sets can 
include folders, their subfolders, individual files, wild-
cards and even exclusions. It  even includes a backup set 
creation Wizard to help you get started quickly.  
 
Also included is a handy T imed Backups Manager 
which allows me to schedule hands-free backups at any 
time. I generally perform this task on Saturday evenings 
when I’m out, so I just leave the computer on that eve-
ning. Command line & desktop shortcut backups can 
also be performed easily. Backup Plus allows full con-
figuration including naming backups according to the 
system date, password protection, backup tracking and 
full backup logging.  I normally schedule my laptop to 
scandisk and defrag weekly. Now I can ensure the safety 
of my data before my weekly maintenances are sched-
uled.  
 
If disaster strikes and you need to restore your data, my 
precious data can be restored to its original location or 
alternate locations. Full folder information is restored if 
requested as well. Individual files, full folders, sub fold-
ers and even entire backups can be quickly restored 
from any backup.  
 
If you're looking for a powerful and easy-to-use backup 
product, Backup Plus is the one for you. You can 
download the Shareware trial version, which allows you 
to try Backup Plus for 21 days. The full version can be 
purchased for $39.95 from AVANTRIX Inc at: 
www.avantrix.com or phone 1-877-448-1491. 
  
Minimum System Requirements: 
Pentium 100 or better 
Windows 95,98,NT, 2000 and XP 
6 MB RAM 

What is it ? Be the first  one to tell me what it  is at the 
meeting and win a prize.  (Mike McEnery (Must be pre-
sent  at  the meeting to win)) 

Sorry -  Board members and their families are not eligible.   
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How To Get the Most out of 
Your Digital Camera 
Part-5 
By Pegasus Staff Writer 
 
VIEW, STO RE AND ARCHIVE YO UR IMAGES 
As in the working world, so it is in the digital photogra-
phy arena. It’s not what you make; it’s what you keep. 
And, you’ll discover how quickly your downloaded im-
ages will clutter up your computer and find their way to 
the nether regions of your hard drive if you don’t have a 
plan in place for safely and neatly organizing and pre-
serving those images. 
As a general rule, keep everything, even images that you 
consider to be mistakes. Organize by folder, giving each 
folder a subject and date line. The most crucial aspect of 
image storage is to ensure that original images are kept 
safe and sound from permanent corruption by image 
editing programs. Always alter a copy of an image, 
never the original image itself. And, when working in 
JPEG format, be aware that each time you alter and re-
save an image in JPEG, image detail is being lost due to 
JPEG’s file-compression methodology. 
Many digicams include image-viewing, editing, thumb-
nail, and archiving software. Use it  or obtain more pow-
erful commercial software. As multi-megapixel images 
are fairly large in size, you’ll soon have an unwieldy 
mass of image files taking up an unfair share of your 
computer’s hard drive. At the very least, you should use 
Iomega’s Zip removable media that can store images on 
100MB or 250MB disks (depending on the model). Or 
better yet, use inexpensive recordable CD-R (record 
once) or CD-RW (re-writeable) media with internal or 
external CD drives, (burners). 
Don’t rely on your computer’s hard drive to perma-
nently house your image collection. Hard drives con-
tinue to fail with alarming frequency. So be sure to ar-
chive your images on removable media, such as Zip 
disks or CDs. As a good general practice, download im-
ages from your digicam as soon as possible. You don’t 
want to mistakenly erase images from your media card 
that you haven’t off-loaded to your computer yet! 
 
PRINT YO UR IMAGES 
There are several ways of printing images suitable for 
framing. A growing proliferation of Internet-based 
photo finishers, as detailed in this magazine from time 
to time, can take all of the guesswork out of your hands 
and help avoid the cost of investing in photo-quality 
ink-jet printers, paper and ink cartridges. 
Many photo-finishing outlets also provide this service to 
digital photographers. There are even customer-operated 
kiosks in some locations where you can automate the 

process on your own. Most likely, though, you will want 
to own a photo-quality ink-jet printer, retailing any-
where from $100 to about $399. 
Regardless of printer or paper brand, the best-printed re-
sults are obtained by following these good practices: 
Don’t scrimp on paper quality. Choose a name-brand, 
glossy photo paper. This premium glossy paper is ex-
pensive, but you’ll be discriminating in your use and 
will only output your best images on it . 
 Let the printer’s proprietary software determine the 
sizes and ink settings to maximize the quality of the im-
age. 
 Print as many images on a single sheet of glossy photo 
paper as possible. Let the printer’s software design the 
page layout to get the most use out of a single sheet of 
glossy paper. 
 Set your printer to output the image at the highest qual-
ity possible. Then, when it’s printed, let the image dry 
for a substantial period of time, even overnight. 
 Don’t expect your printer to make up for inferior image 
quality from the start. A poorly lit , badly focused, or im-
properly composed photo will only look worse when 
printed, regardless of how high you set the print quality. 
 Always downsize from the electronic image, never up 
size. Printing an image larger than its original size will 
result  in pixilation, observed as loss of detail and focus. 
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Printing Your Digital 
Photos 
 

 
Even though we live in the Information Age and almost 
everything is done electronically, there are many rea-
sons to create “hard copies” of your digital photos. 
Printed digital photos are much the same as traditionally 
developed pictures and can be shared in offline photo 
albums kept in a picture frame and mailed to your non-
computer savvy friends, family and co-workers. 
There are two main ways to print your digital photos: do 
it  yourself or have someone else print them for you.  
Do It Yourself 
If you want to print your own digital photos, you are 
going to need a good printer and photo paper. A normal 
ink-jet printer will do an average job printing a digital 
photo (the better the printer, the better the quality of the 
printout). However, a printer specifically developed to 
print photos will provide much better quality and lon-
gevity. 
The most popular photo printers include those by Ep-
son and Hew lett Packard. Hewlett Packard offers the 
PhotoSmart printer series which allows you to print 
photos directly without the need for a computer. Epson 
ink-jets are known for their high quality and low cost. 
Be sure to consider both your photo printing and regular 
printing needs when selecting a printer. 
You can find photo paper, both glossy and matte, at of-
fice supply stores. There are many suppliers, including 
Kodak. 
Have Someone Else Do It 
Traditional brick and mortar stores are now offering 
digital photo printing services. The Kodak Picture 
Maker kiosk or Fujifilm's Aladdin can be found in pho-
tofinishers in many cities and towns. Simply take a trip 
to your local processor and bring along your digital 
camera media. 
Online sites also offer photo printing services. Ease of 
use is their primary offering: simply upload your digital 
photos to their site and select your print options. Online 
providers include: Ofoto, Printroom, eFrames, 
PicServe and Shutterf ly.  
Before choosing an online provider, consider the fol-
lowing: 

Print Sizes  
Prices  
Shipping Cost  
Return Policy  
Quality Guarantee (do they guarantee the quality of the 
photo?)  
Privacy Policy (will they share your personal informa-
tion?)  
Printing Options (do they print on non-traditional media 
such as coffee mugs or mouse pads?)  
Uploading Options  
Printer (what kind of printer do they use?)  
Paper (what kind of paper do they use?)  
 
Resolution is Important 
Keep in mind that a higher resolution will mean clearer 
photos. The minimum resolution to achieve acceptable 
printed results is as follows: 
 

 

Photo Print Size Suggested Pixels 

3" x 5" 1024 x 767 
4" x 6" 1280 x 960 
8" x 10" 1600 x 1200 

Web-Watch  
Kool Sites are informative, weird, stylish, offbeat or 
unique. 
KIDS' SITE O F TH E WEEK: LO VE TO  CO LOR - 
Kids can choose a picture on this site and color it  on-
line. Or they can print the pictures and use crayons. 
www.colorpalooza.com 
 
DOWNLO AD CALCULATO R- Use this calculator to 
predict how long downloads will take. 
Tell this site what type of connection you have, along 
with the file's size, and it will estimate the download 
time. www-sci.lib.uci.edu/HSG/AATimeCalc.html 
 
BAD MIDI MUSEUM - Many midi songs sound like 
bad synthesizer rip-offs. Here is a 
museum of the worst midi songs. http://
litt leitaly.fortunecity.com/vatican/791/midi.htm 

Continue on page 7 
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www.ccxpo.com 
 

All L.C.A.C.E. Members who present their membership card will receive a $1 discount. 

CCXPOCCXPOCCXPOCCXPO    
 Save u

p to 70%
  FREE Parking  

Great prices! Bargains galore! Great prices! Bargains galore! Great prices! Bargains galore! Great prices! Bargains galore!     
Gurnee Holiday Inn 

Main Ballroom 
6161 W. Grand Avenue  
Gurnee, Illinois 60031 

April 7 , 2002 
9:30 am - 3:30 pm 

$6 Admission 

Profile of the Month 
My name is: Marshia Hobson 
My Job is: Admin Assistance 
Family: Sister in Los Angeles  
My Hometown is: Los Angeles 
For entertainment I like: Roller Skating, 
Bowling 
A book or movie I would recommend: False 
Memory (audio book) 
My Favorite meal would be: Chicken Kiev 
My prized possession: Infinite  QX3 (SUV) 
Someone I admire: My pastor Apostle John 
Eckhandt 
I wish I could stop: having slow responses 
I want people to remember me as: Ms. 
Gadget 
I use my computer for: Desktop Publishing, 
Word-processing 
My favorite computer program: Word Perfect 
My favorite phrase or expression is: N/A 
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CELEBRITY ADS  - Even superstars reach for the 
quick buck. This site has commercials and other embar-
rassing TV endorsements featuring some of the world's 
biggest celebrities. www.gaijinagogo.com 
 
CONTES T SITE O F THE WEEK: OWN THE 
ROAD -   http://www.gaijinagogo.com/Enter to win a 
2002 Ford Explorer SUV. You can take it  off-road or 
just cruise through the city in style. 
www.gaijinagogo.com 

TAKE THE DSL ADVENTURE TOUR - SBC 
DSL has pulled together some of the greatest resources 
for you and your family.  

•  Streaming Media  

•  Privacy  

•  Blocking Sites  

•  Downloading Software  

•  Home Networking Basics  

•  Email Netiquette  

•  Security Considerations  

•  Archiving and Backup  

•  Hosting Options  

•  Remote Access  

•  Building a Personal Web Page  

•  Advertising Your Site 

Win Tips - Windows 98/ME 
Delete Images in the My Pictures Folder 
If you receive an error message which says: Cannot De-
lete Filename, Access Is Denied, The Source File May 
Be In Use, you may have tried to delete an image from 
the My Pictures folder or from another folder. Microsoft 
notes that if Web view is enabled, and you open the My 
Pictures folder or any customized folder that uses the 
Image Preview template, selected images display in the 
Image Preview window and are considered in use. So, 
while the image is being drawn, a Generating Pre-
view...message displays in the Image Preview window, 
and the file locks up so you cannot delete it . To disable 

Web view, select Folder Options from the Tools menu, 
then click the General tab's Use Windows Classic Fold-
ers option. 
 
Be Sure Borders Print 
If a page border doesn't  appear on a page when printed, 
it  may be because the border extends beyond the print 
range allowed by your printer.  
To print the border, you may have to increase the size of 
the left  and right margins. To make the borders fall 
within acceptable page margins, choose Select All from 
the Edit menu, then Borders and Shading from the For-
mat menu. Click the Page Border tab. Note the width of 
the border line in the Width drop-down list .  
Click the Options button. The Border and Shading Op-
tions dialog will appear. Select Text from the drop-
down box tit led, Measure From. Note the distance (in 
points) for the left and right margin settings. Click OK, 
then click OK again to close both dialog boxes. Select 
Paragraph from the Format menu. Click the Indents And 
Spacing tab. In the left  and right boxes of the Indenta-
tion section, type the number of points equal to the com-
bined width of the border and the spacing specified in 
the Width and From Text boxes.  
For example, if the Border width was 3 points (pt) and 
the right and left  From Text boxes specified 4 points, 
enter 7 pt in each of the Left and Right boxes (If you 
don't enter Pt, Word will think you mean inches and 
won't  allow the changes). Click OK. 

These are the people who
have been nominated for
office:

   Jim Rutledge 
 Linda Busch 
 Les Larkin 

 Mike McEnery   
 Larry Grauzas Sr. (Mr. "G") 

 J.J. Johnson 
 Robin Seidenberg  

 Terri Hanlon 
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The following is a listing of available LCACE members’ E-
Mail addresses: 
 
Ruth Donahue-Allisonr  allison98@juno.com 
Jim Ashworth                 Blue_unicorn@netzero.com 
Corky Bell                      corky@foxvalley.net 
Bobby Bell                     Bozo160@hotmail.com 
Donna Bell                    niteangel85@hotmail.com 
Bob Berry                      tberry64@aol.com 
Kerry Broughton            kerrybroughton@hotmail.com 
William & Diane             Brumbachbbrumbach@cs.com 
Linda Busch                   lindashrub@juno.com 
Bob Carpenter               cubs14@bigfoot.com 
Lisa Carter                     onedrwmn@juno.com 
Rich & Pat Crocker        RCPC75@aol.com 
Randell Durk                  randell@voyager.net 
Vic Falkner                     rvf@se-iowa.net 
Tom Fitzsimmons           tomfitzsimmons@juno.com 
Jack Frost                       jfrost@megsinet.net  
Mr. & Mrs. G                   MrG3165@aol.com 
Phil Grimm                     pgrimm@surfree.com 
Joe & Mary Griesemer   moraine@netwurx.net 
Arnie Gudyka                 arngood1@juno.com 
Marta Mata-Guzman      marta59@aol.com 
Terri Hanlon                   Terhanlon@aol.com 
Marshia Hobson             marsgraphics@netscape.net 
Tom Hudock, Jr.            TEEPEE21@aol.com 
Dwight (J.J.) Johnson    j j1450xl@ix.netcom.com 
Donna Kalinoski             donnaleek@juno.com  
Steve Kostelnik              steve_kostelnik@usa.net  
Lester Larkin                  LesLarkin@NetZero.net 
John Lawless                 jay@iwc.net 
LeRoy & Bernice Long   Roylord@msn.com 
Mike McEnery                 mmcenery@core.com 
John Nabors                   jog@nomad.net 
Larry Nixon                     nixonl@earthlink.net 
Lee Nordstrom                 LeeNord@mw.sisna.com 
Jeffrey J. Notter              jnot@email.com 
Anna Ross-Rodgers      Anna.Ross-Rodgers@ReliaStar.com 
Ken Rogers                   drken@enteract.com 
Marcia Rose                  Mrose74801@aol.com 
Bruno Rusanowski        BRFJR@earthlink.net 
James Rutledge             jrutnet1@home.com 
Leslie Salsburg              leslie164@juno.com 
Paul Schintgen              paulj@theramp.net 
Walter Sheets                eddoc85@netzero.net 
Gerald Straw                 pilotgks@concentric.net 
Bob Tuttle                      btuttle@ix.netcom.com 
Bruce Welsch                brwelsch@hotmail.com 
Steve Yeaton                 hiflyer9@bigfoot.com 

 
As much as we try, we do make errors. Please advise  us if 
there is a mistake in your E-Mail address or if it is not 
included in this listing.  Send E-Mail to lcace@inf-net.com 
with the additions and/or corrections. Thank you. This 
listing last updated - November 3, 2001 

Members Web Sites 

Corky Bell 
http://www.users/foxvalley.net/~corky 

 
Phil Grimm 

http://www.public.surfree.com/pgrimm 
 

J.J. 
http://www.picturetrail/lcace 

TIME TO RENEW 
Renewals will  be posted on our  WEB site  which is: 

http://www.inf-net.com/lcace 
If it is time for you to renew your membership, 
please fill  out a new Application and a Member’s 
Profile  Sheet. These forms can be obtained at the 
meetings or  downloaded from our WEB site . 
 
If you do not want your name published in the News Jour-
nal for any reason, please e-mail me and I will respect your 
wishes. 

See the CLUB PICTURES CLUB PICTURES CLUB PICTURES CLUB PICTURES at: 
 
 

 
 
 

Members 

Take a look, 
you just 
might see 
yourself. 

www.picturetrail.com/lcace  

Your Advertisement could 
have been placed here. 

 
L.C.A.C.E. 

c/o Group Ambassador 
409 S. Elmwood Ave. 

Waukegan, Illinois 60085-5219 
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All dial up service includes (1) E-Mail account. Additional E-Mail 
accounts as little as $2.50/mo. For more details call us at (847) 543-1350 
or send me an E-Mail at postmaster@inf-net.com. Applications for 
dial-up service available via E-Mail. 

infiNET DIRECTions inc. 
we have the means to take you there... 
 
549 N. Rt. 83, Grayslake, IL 60030 
847.543.1350 
 

Complete Internet Service Includes: 
Dial-up Service $18.00/mo. 
Home Pages Starting at $50.00/mo. 

♦  56k Dial-up Service 
♦  FTP Site Available 
♦  E-Mail Service 
♦  Home Page Design 
♦  Home Page Storage 
♦  Domain Name Registration 
♦  Windows & Networks setup & installation 
♦  Free Ads for selling your personal merchandise on the 

Web (visit) site: www.inf-net.com for more info. 

CALL FOR INFO: 847.543.1350 



 

NEXT MEETINGNEXT MEETINGNEXT MEETINGNEXT MEETING    
    

April 13, 2002 
 

Grayslake Public Library 
1200—3:00pm 

 
This month: 

 

Elections 
Something New 

Special Interest Group(s) 
Kick Off 

Printing & Mailing by L.C.A.C.E., Lake County, IL 

L.C.A.C.EL.C.A.C.EL.C.A.C.EL.C.A.C.E    
Lake County Area Compuer Enthusiasts 
409 Elmwood S. Ave. 
Waukegan, IL 60087-5219 

ADDRESS CORRECTION REQUESTEDADDRESS CORRECTION REQUESTEDADDRESS CORRECTION REQUESTEDADDRESS CORRECTION REQUESTED    

L.C.A.C.E Online 
View our Sites 

www.inf-net.com/lcace 
http://lcace.tripod.com 

 
E-Mail Us At: 
lcace@inf-net.com 

 
Club Photos 

http://www.picturetrail.com/lcace 
 

♦  LCACE E-mail addresses 
♦  LCACE information  
♦  LCACE history and pictures 
♦  LCACE meeting, location and map 
♦  LCACE members  e-mail addresses 
♦♦♦♦  

  

 LCACE online membership application    


